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To complement the deployment of thousands of computers into schools across the developing world,
LiteHaus International has developed this ‘Teaching Digital Skills’ Unit with teacher training resources
and an 11-week teaching curriculum in the form of a unit plan. This will serve as an invaluable primary
resource to guide teachers with no formal training or limited competency in teaching IT and using
computers, providing a structured and detailed curriculum for teaching digital technologies. 

The plan breaks down the learning objectives, lessons, and helps to create assessments in a clear and
strategic manner, making it easy for teachers to follow along and implement in their classrooms for 11
weeks of the teaching year.

Following this unit plan, teachers can gain a better understanding of how to introduce students to
fundamental digital skills such as typing, using word processing software, working with spreadsheets,
creating presentations, and even basic coding. The plan includes specific lessons and activities that guide
teachers on how to teach these concepts effectively, even without prior IT training.

Further, the unit plan covers topics such as e-safety, cyberbullying, misinformation, and being a good digital
citizen, which are important for students to learn as they navigate today's digital age. By following this plan,
teachers can help students develop essential digital literacy skills and knowledge while also ensuring their
safety and well-being in the online world. Teachers will be able to use these resources to train themselves
and build greater digital capability. 

LiteHaus International’s ‘Teaching Digital Skills’ Unit is not just a resource; it is a gateway to a world of
digital knowledge and empowerment for both teachers and students. In offering a structured and detailed
curriculum in the form of a unit plan, LiteHaus International is not only working to bridge the digital divide
but also striving for a future where quality education is accessible to all.

We wish all users of this resource every success on your digital learning journey.

Kind Regards,

PREFACE
LiteHaus International is an Australian charity and NGO which
exists to tackle digital inequality and expand educational
opportunities for students across Asia-Pacific. Starting in Papua
New Guinea (PNG) back in 2017, our digital equity programs have
provided digital learning outcomes for over 250,000 people in ten
countries, including Australia, PNG, Philippines and the wider
Pacific and South-East Asia regions.

Jack Growden

Founder & CEO LiteHaus International
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LiteHaus International’s ‘Teaching Digital Skills’ Unit builds on concepts, skills and processes for early
digital learning. It focuses on developing foundational skills in computational thinking and an awareness of
personal experiences using digital systems.

Students develop understanding and skills in computational thinking, such as categorising and outlining
procedures; and developing an increasing awareness of how digital systems are used and could be used at
home, in school and the local community.

Students develop understanding and skills in computational thinking such as identifying similarities in
different problems and describing smaller components of complex systems. It also focuses on the
sustainability of information systems for current and future uses.

Students begin to learn about common digital systems and patterns that exist within data they collect.
Students organise, manipulate and present this data, including numerical, categorical, text, image, audio
and video data, in creative ways to create meaning.

Students use the concept of abstraction when defining problems, to identify the most important information,
such as the significant steps involved in creating a letter in the appropriate format. Students describe how
information systems meet information, communication and/or recreational needs.

Through discussion with teachers, students learn to apply safe and ethical practices to protect themselves
and others online. Students collect, manipulate, and interpret data, developing an understanding of the
characteristics of data and their representation.

When creating solutions, students will give reasoning to show understanding of the problem, the date
necessary and the requirements to meet a solution. They will design a solution with thought to how it will
affect their environment in a positive manner.

INTRODUCTION TO
TEACHING DIGITAL
SKILLS UNIT

PURPOSE & OBJECTIVES

LiteHaus International has created this ‘Teaching Digital
Skills’ Unit using the Australian Curriculum as a guideline for
the descriptors.
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1.To understand the basics of using a computer and its functions.
2.How to be proficient in using a keyboard and typing using Typing Master.
3.To use Microsoft Word to create documents, forming sentences, paragraphs andinserting images.
4.To use Microsoft Excel to collect & input data and to analyse information about theircommunity.
5.To use Microsoft PowerPoint to present findings from the data about their community.
6.To understand the basics of coding with Scratch, completing various tutorial activitiesdemonstrating
the use of code.
7.To understand the basics of e-safety and how to be good digital citizens.

LEARNING INTENTIONS

Students will learn:

1.Set up, turn on and use the applications on the computer.
2.Use the keyboard and meet the standards set by the teacher in the typing program.
3.Use Word documents to write sentences, paragraphs and create documents.
4.Input data into Microsoft Excel, then analyse the information to draw valuable insights.
5.Use Microsoft PowerPoint to effectively present findings in an appropriate presentationformat.
6.Use the fundamentals of coding offered in Scratch to create animations, games andother activities.
7.Be safe online and a good digital citizen.

STUDENT SUCCESS CRITERIA

I can:

Lachlan Parker

Training and Development Lead at LiteHaus International

Students develop their skills in applying technical protocols such as devising file naming conventions that
are meaningful and determining safe storage locations to protect data and information.

When engaging with others, students take personal and physical safety into account using e-safety and
other methods. They will put this into practice with several scenarios that target social differences and
privacy for personal information.
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Sly Vii Joan is a teacher at Aviamp Primary
School in rural Jiwaka, Papua New Guinea
(PNG). When LiteHaus International was
founded, few of the 3,500 schools in PNG had
quality digital learning infrastructure. Aviamp
Primary School was one of them until
LiteHaus International stepped in with Deloitte
and the Sir Brian Bell Foundation to install a
computer lab. 

When Aviamp Primary School received the
computers, Sly Vii saw this as an opportunity
to further her studies and enrolled in a
university computer course. Now, she is the
IT Teacher at the school.

Sly Vii has developed a daily schedule for
digital classes and graduated Grades 3 to 8,
and organises free computer lessons for
teachers after hours.

CASE STUDY: 
AVIAMP PRIMARY SCHOOL

“I always say to my
students, that nowadays
mastering computing is a
survival skill.” 
- Sly Vii Joan IT teacher at
Aviamp Primary School.
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WEEK 1 – FUNDAMENTAL DIGITAL SKILLS 
Learning Intention: 
To understand the basics of using a computer and its functions. 
 
Student Success Criteria: 
I can set up, turn on and use the applications on the computer. 
 
Digital Skills Training Manual Reference: 
Pages 18 – 27 
 
 
Lessons 1-3 
 
Fundamental Digital Skills  
 
Students will learn fundamental digital skills of computing such as: 
 

o How to connect, turn on a computer and use applications. 
o Understanding various components of a computer such as the mouse, 

keyboard, screen, cursor, and their applications. 
o How to open applications and begin to familiarise themselves with programs 

and locations of folders on provided USB. 
 

WEEK 2 – TYPING 
Learning Intention: 
To develop digital skills with the keyboard and learn to type effectively and efficiently. 
 
Student Success Criteria: 
I can use the keyboard and meet the standards set by the teacher in the typing program. 
 
Digital Skills Training Manual Reference: 
Pages 28 – 34 
 
 
Lesson 4 
 
Typing – Extra Courses: Keyboarding, Numbers, Specials, 10-Key 
 

• Students will complete in the Typing Master Extra Courses, splitting into groups to 
ensure sufficient time for all participants. 

• Students will be split into groups, so each will have a go. Once one is finished, the 
next will have their go. 

• Students will start with the Junior Typing Course; this will help them learn the keys. 
• Students will use this information to benchmark their abilities and identify areas for 

improvement.  
• Students can repeat this process as many times as needed to build their skills. 
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Lesson 5 
 
Typing – Games 
 

• Students will complete the Games section of Typing Master, splitting into groups to 
ensure sufficient time for all participants. 

o These games are designed to help students learn the keys, find them quickly 
and type words correctly at a comfortable pace. 

o Start students on the letters A-Z, once they become comfortable finding 
letters, get them to move onto words. 

o Students should practice this as many times as needed, until comfortable. 
Recommended 2-3 times each at least. 

o If students are done earlier than others or are finding it easier, start a 
competition to see who can get the highest score. 

 
Lesson 6 
 
Typing – Speed Building Course 
 

• Students will complete the Speed Building section part Typing Master, splitting into 
groups to ensure sufficient time for all participants. 
 

Students will use the skills they have practiced with the keyboard to improve their typing 
speed. This will help them to become more comfortable typing and memorising the 
keyboard, improving the speed in which they can type  while minimising errors. 
 
WEEK 3 – TYPING (Continued) 
Learning Intention: 
To master usage of the keyboard and learn to type effectively and quickly. 
 
Student Success Criteria: 
I can use the keyboard and meet the standards set by the teacher in the typing program. 
 
Digital Skills Training Manual Reference: 
Pages 28 – 34 
 
 
Lesson 7 - 9 
 
Typing Tests 
 

• Students will complete typing test activities, curated by the teacher on Typing 
Master. Typing tests are a good way for students to practice what they have learnt 
so far. 

o Students can adjust the activity duration and review the results to determine 
areas of improvement.  
 It is recommended that students start with the following: five-minute 

duration | 25 WPM (words per minute). 
 As performance improves, students should progress to the 35 WPM 

activity. 
Students can be assessed based upon the words per minute and accuracy.  
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WEEK 4 – MICROSOFT WORD 
Learning Intention: 
To use Word documents to write sentences, paragraphs and create documents. 
 
Student Success Criteria: 
I can create a letter using Microsoft Word. 
 
Digital Skills Training Manual Reference: 
Pages 35 – 41 
 
Lesson 10  
 
Students will use Microsoft Word to create a letter to a pen pal. 
 
This lesson will focus on the layout of the letter. 
 
Students will be creating a template to write to their pen pal. It will need to follow this layout: 
 
Your name                                                                                                                                     Date 
School 
  
Topic/Title 
 
Dear Australian Student 
 
 
Write paragraph and content here 
 
 
Kind Regards 
 
Your Name 
 
 Before instructing the students to write the letter, have a discussion on the following: 
 

• The importance of layout in producing a quality email.  
• The importance of formal language in an email.  
• Brainstorm some idea about topics that can be included in the letter as a class. 

 
Students should aim for one paragraph on their favourite subject at school and what they 
have learnt. This will develop further as time goes on. 
 
Lesson 11  
 

• Students will practice the same activity, this time writing a longer letter to a family 
member (two or three paragraphs to build broader competencies). 

o The topics they must write about are: 
 Friends at school and what they enjoy doing; 
 What they hope to achieve in the future and how they will get there;  
 What they enjoy about the village and what they hope they can help 

to improve. 
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Lesson 12  
 
Word Assessment – Writing to a Pen Pal (pg. 37-38) 
 

• Students will be assessed on their ability to write to a pen pal. 
o This must be completed on their own as they are being assessed. They will 

need to make sure they use the correct template. 
o It must include bolding, underlining, using different coloured text, making lists 

and the other formatting tools learnt so far. 
• They must include the following information to their pen pal: 

o Who they are, what their village is called and who is important in the village. 
o What they are learning at school, what they hope to achieve with an 

education and how they are finding the digital learning world. 
o Who their friends and family are some interesting facts about them and about 

the lifestyle of their village/people. 
o What do they want to know about Australia? They should ask the pen pal 

from overseas some questions. 
 
Finish off with anything else they want to say, something that is not mentioned here that 
they can think of? We suggest brainstorming as a class for ideas of what you can talk about. 
 
WEEK 5 – MICROSOFT EXCEL 
Learning Intention: 
To use Microsoft Excel to input data and analyse information about students’ home communities. 
 
Student Success Criteria: 
I can input data into Microsoft Excel, then analyse the information to draw valuable insights. 
 
Digital Skills Training Manual Reference: 
Pages 42 – 54 
 
Lesson 13  
 
Excel – Inputting Data (pg. 42-43) 

•  Students will learn the capabilities and fundamentals of navigating the Excel 
program. 

• Students will learn to input raw data into appropriate columns and use the basic 
=sum function to add up results. 

• Students will repeat and practice the process. 
 

Lesson 14 

Excel – Data Analysis 
• Students will master more complex functions such as =if(), =sum(), =count() to draw 

meaningful insights from the data.  
• Students will be shown examples of real world applications for Excel. 
• Students will practice sorting the data into categories such as female and male, age 

groups, etc.  
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Lesson 15 

Excel – Illustrating Data in Graphs 
• Students will generate graphs from the data to present the findings in a visual form. 
• Students will learn which graphs are best for certain types of data. 

o Students will use bar, line and pie graph as examples. 
• Students will learn real world applications for graphs and charts. 

Students will explore elements of the graph function such as colour, titles, legends, etc. 
 
WEEK 6 – MICROSOFT EXCEL (Continued) 
Learning Intention: 
To use Microsoft Excel to input data and analyse information about students’ home communities. 
 
Student Success Criteria: 
I can input data into Microsoft Excel, then analyse the information to draw valuable insights. 
 
Digital Skills Training Manual Reference: 
Pages 42 – 54 
 
Lesson 16 - 19 
 
Excel – Advanced Data Analysis & Presentation 

• Students will master more complex and useful commands such as =sumif() and  
=countif(). 

 
Students will continue to practice with different data sets, revisiting areas of difficulty to 
ensure the learning intentions are met.  
 
WEEK 7 – MICROSOFT EXCEL (Continued) 
Learning Intention: 
To use Microsoft Excel to input data and analyse information about students’ home communities. 
 
Student Success Criteria: 
I can input data into Microsoft Excel, then analyse the information to draw valuable insights. 
 
Digital Skills Training Manual Reference: 
Pages 58 – 59 
 
Lesson 20 – 22 
 
Excel Assessment (3 lessons) 
 

• Students will complete an Excel assessment,  
o They should be allowed to use the course material provided as well as their 

own notes from the previous lessons. 
• Students should be given new datasets and instructions to test their abilities. They 

will need to go through the steps and remember how to achieve the outcome asked 
of them in the assessment. 

• Students will be marked on how much they are able to do on their own. 
 
Marking criteria for this exercise will be created during teacher training. 
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WEEK 8 – MICROSOFT POWERPOINT 
Learning Intention: 
To use Microsoft PowerPoint to present the information about their community, using word to help 
write a script and present it as a presentation. 
 
Student Success Criteria: 
I can use Microsoft PowerPoint to effectively present findings in an appropriate presentation format. 
 
Digital Skills Training Manual Reference: 
Pages 55 – 57 & 62 
 
Lesson 23 
 
PowerPoint – Presenting Findings from Excel Activity 
 

• Students will be learning how to make up a presentable slide using skills such as 
logos, backgrounds, text break up and other components. 

• Students will need to make sure it looks professional by using different slide formats, 
and correct placement of pictures and text. 

• Students will learn how to make the presentation flow effectively, how many words 
should be per slide, images, layout, etc, following guidelines in the Training Manual. 

 
Lesson 24 
 
PowerPoint – Presenting Findings from Excel Activity 
 

• Students will learn how to present information and findings using slides, 
incorporating data, explanations and other skills. 

• Students will practice these skills using different countries as the examples, creating 
an informative presentation on the chosen country. 

• Students will create questions that will be used a basis for the presentation 
information, such as what is the food the country is known for? What resources does 
the country have? What is the population? 

• Students will use these skills to create informative slides. 
 
Lesson 25 
 
PowerPoint Assessment – Presentation in Front of Class (pg. 62) 
 

• Students will create slideshow presentation on a topic given by the teacher. 
• Students will need to complete this on their own using the steps practiced in previous 

lessons. 
• Students will need to make sure they use the correct formatting and make it 

presentable to the class. 
 
Students will then present their PowerPoint to the class to show their knowledge and skills. 
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WEEK 9 – FUNDAMENTALS OF CODING 
Learning Intention: 
To understand the basics of coding with the scratch program, completing various tutorial activities 
that show the use of code. 
 
Student Success Criteria: 
I can use the fundamentals of coding offered in Scratch to create animations, games and other 
activities. 
 
Digital Skills Training Manual Reference: 
Pages 63 – 67 
 
Lesson 26 – 28  

Introduction to Coding for Students (Scratch) 

To find coding tutorials, go to the folder titled LiteHaus E-Library English. Locate the ICT 
folder. Locate the Scratch folder. Inside this folder will be the Scratch installer for the 
program, as well as video tutorials for the lessons. 
 

• Please note: More lessons can be created using the resources provided to you in 
the Scratch folder. The aim is to teach students the basics of coding and further 
develop this throughout the year. 

• Video tutorials have been provided in the Scratch folder. Students are encouraged 
to also play around with the program and try different strategies out on their own as 
well. 

 
When beginning with scratch you will begin to use an image called a sprite, which can be 
commanded to do various actions depending on the code. It is encouraged to try out a few 
commands with the sprite. 
 
Once comfortable with the sprite your creation can be taken further by adding other sprites, 
objects, backgrounds and much more.  
 
When these skills are mastered projects such as animations and games can be created. 
 
Here are some of the goals you can have the students try to complete for this week using 
Scratch: 
 

• Create a Character, make it move (Video Tutorial Create a Sprite with Scratch 
Paint Editor for guidance) 

• Make a Background and Scrolling Background (Video Tutorial How to Make a 
Scrolling Background in Scratch for guidance) 

• Create a Jumping Game (Video Tutorial How to Make a Jumping Game in Scratch 
for guidance) 

• Make a Catch Game (Video Tutorial How to Make a Catch Game in Scratch for 
guidance) 

 
Extra video tutorials have been provided for students to complete throughout the 
year. 
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The videos will involve the students developing their skills with basic movements, then 
adding in other functions such as landscapes, shapes and much more. Eventually creating 
small animations using what they have learnt. 
 
It is recommended that teachers have a look and play around with Scratch to get the 
basic idea. Scratch comes with sprites, backgrounds and sounds ready to use. You 
can choose to create your own later, but there are many available already. 
 
WEEK 10 – E-SAFETY 
Learning Intention: 
To understand and recognise online threats and be equipped to be a good digital citizen. 
 
Student Success Criteria: 
I understand how to be safe online and be a good digital citizen. 
 
Digital Skills Training Manual Reference: 
Pages 63 – 67 
 
Lesson 29 
 
LiteHaus Module - E-Safety (read presentation prior to teaching) 
 

• Focus of Module: 
o Becoming more aware of online threats and promoting safer and positive 

online experiences. 
o Tips for staying safe online and what to look out for. 
o Where to find out more information on e-safety. 

• Questions to focus on: 
o What can be done to keep students safe? 
o What are the best practices to keeping safe online? 

• Points to cover: 
o Be sure to teach from the perspective of, being new to the digital and online 

world, being safe early is best. 
o Create a list of what students can do, what adults/teachers can do to assist 

in being safe online. 
o Explore content further with students by participating in class discussions 

about their own experiences. 
o Conduct activities that reflect upon decisions and discuss possible solutions 

to problems. 
 

Lesson 30 
 
LiteHaus Module – Cyberbullying (read presentation prior to teaching) 
 

• Focus of Module: 
o What is cyberbullying? How to deal with it effectively. 
o Platforms in which cyberbullying can occur. 
o The impact it has on people and could have on you. 
o What can happen if you are the bully. 

• Questions to focus on: 
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o Start with conversation on what cyberbullying might be? This may be an 
uncommon topic for students since they are new to technology. 

o Why is it important to learn about this issue now? 
o How can we avoid the issue in the future? 
o What solutions can we use to help us avoid cyberbullying as new users to 

the digital and online world? 
• Points to cover: 

o Cyberbullying, what it is, how we can prevent it and help each other. 
o While going through slides, have discussion on the points, get students 

involved. 
o Make sure to emphasise the importance of being safe and not being a bully 

to others online. 
 

Lesson 31 
 
LiteHaus Module – Fake News & Misinformation (read presentation prior to teaching) 
 

• Focus of Module: 
o The difference between fake news, misinformation and disinformation. 
o How to identify fake news.  
o Why it is important to see the signs. 
o The impact fake news can have on you and your community.  

• Questions to focus on: 
o Start with what is misinformation?  
o Why is it important that we make sure information is correct? 
o What kind of information is available to us right now? 
o Why is online information different? 
o How can we tell if it’s correct or trustworthy? 
o Can we believe everything we read from one site? 

• Points to cover: 
o Make sure to discuss the ideas of each slide as you over them. 
o Stress the importance of checking information, using multiple sites to verify 

information. 
o The importance of reading and making decisions yourself from your own 

research. 
o Teach students how to look for information correctly using the internet. 
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WEEK 11 – E-SAFETY (Continued) 
Learning Intention: 
To understand and recognise online threats and be equipped to be a good digital citizen. 
 
Student Success Criteria: 
I understand how to be safe online and be a good digital citizen. 
 
Digital Skills Training Manual Reference: 
Pages 63 – 67 
 
Lesson 32 
 
LiteHaus Module – How to be a Good Digital Citizen. (read presentation prior to teaching) 
 

• Focus of Module: 
o Suggestions on how to be a good digital citizen. 
o The importance of how you represent yourself online. 
o How to protect yourself as a good digital citizen. 

• Questions to focus on: 
o What is a good digital citizen? 
o What do you think you need to do to be a good digital citizen? 
o What will you do to help yourself become a good digital citizen? 

• Points to cover: 
o Explain the importance of being a good digital citizen in the digital world. 
o Explain they are setting the example not only for themselves, but for their 

peers and families. 
o Express how it is about creating a positive future for your community and 

country. 
o Explain the importance of learning and helping each other through this 

journey. 
 
Lesson 33 
 
LiteHaus Module – Computer Safety and Basic Troubleshooting (read presentation prior to 
teaching) 
 

• Focus of Module: 
o Suggested web browsers and anti-virus software for the computer. 
o How to fix basic problems the computer may have during usage. 
o Parent safety features, firewalls and how to search up issues. 

• Questions to focus on: 
o What issue may we run in with our computer? 
o What are some problems you know that are common? 
o How do you think we take care of our computers? 
o Have you seen any of these browsers before? Which do you know? Which 

do you use? 
o Should we trust any anti-virus software? Why/Why not? 
o Why is it important to know how to fix these computers ourselves? 

• Points to cover: 
o Students will need to know how to fix basic problems. 
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o Explain the importance of keeping yourself safe of the computer. 
o Explain why it is important to avoid viruses and not trust every site or 

application. 
 
Lesson 34 
 
LiteHaus Module – Using Digital Technology to Organise Yourself (read presentation prior 
to teaching) 
 

• Focus of Module: 
o Programs and sites that can help with work and home. 
o Programs that are known to work with minimal issues. 
o Benefits of the programs and how they can be used. 

• Questions to focus on: 
o How do you organise yourself every day? 
o How do you remember things? 
o Do you use your phone for a majority of this? 
o How do you think technology can help you with school, life and future work? 
o What are some things you already use/do? 
o What are some things you will give a go to organise yourself? 
o Why is it important to be organised? How does technology help with this? 
o Do you think this level of organisation will help you in your future? 

• Points to cover: 
o Explain why it is important to be organised and punctual in a modern world. 
o Explore how these applications can help someone be on time, not lose 

information and organise their work and personal life. 
 

Practice using some of the programs to organise classroom days/activities as an example 
to students. 
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At the Kunabau Primary School in Chimbu
Province, digital learning classes are held
every day and the school has successfully
integrated digital usage into the daily teaching
of other subjects. Students use the
comprehensive Niunet e-library, which has
over 6.2 million educational articles, to assist
them in their social sciences, mathematics,
and geography projects.
 
We have partnered with Chimbu Provincial
Department of Education and its remarkable
women leaders to complete 32 digital
classrooms since 2022.

CASE STUDY: 
KUNABAU PRIMARY
SCHOOL, CHIMBU.

Every 48 hours, we build a new computer
lab in a school in Papua New Guinea. 94%
of students in PNG do not have regular
access to digital learning tools. Many remote
schools have empty libraries with less than 50
reading books available to students. This
critical shortage of quality learning materials
hinders the delivery of quality education. We
are changing this.

18



Fundamental
Digital Skills

Week 1: Lessons 1-3
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STARTING THE COMPUTER 
 

To start the laptop: 

1. Open the laptop. 
2. Press the power button once (see Image 1). 

Image 1 

IMAGE OF POWER BUTTON 
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COMPONENTS OF THE COMPUTER 
 

There are three main components of a computer: 

1. Keyboard: where the keys all are. The keyboard is used to type. 
2. Mouse: the device used to select programs and navigate the screen. 
3. Screen/Monitor: where the image is displayed 

Image 2 shows all of these parts: 

Image 2 

IMAGE OF THREE COMPONENTS 
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Other parts include: 

1. Charging cable: this connects the computer to power. 
2. USB slots: this is where USB flash drives can be inserted to the 

computer.  
3. Alternative mouse: this can also be used instead of the external mouse 

but is more difficult to use.  

Image 3 shows all of these parts: 

Image 3 

IMAGE OF THREE COMPONENTS 
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HOW TO USE THE KEYBOARD 
 

The keyboard is used to type. Begin using one finger to learn where all the different 
keys are. With practice, you should be able to type with two or more fingers. 

The keyboard can be divided into a number of sections: 

 Alphabet: pressing one of these keys on its own will type a lowercase letter. 
 Numbers: you will see that some of the number keys have symbols like 

“!,@,£,$,%,^”. To access these, hold down the shift key and press the key you 
want. 

 Shift Keys: Hold one of these down when you press a letter key to make it 
CAPITALISED.  

 Space Bar: This key makes a space in between words. Just press this key 
(DO NOT HOLD). 

 Enter Key: This key moves your typing down to another line on the page (in 
Microsoft word). Just press this key (DO NOT HOLD) 

 Backspace: This key removes typing to undo errors. You may just press 
this or hold it. 

Image 4 

IMAGE OF KEYBOARD 
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HOW TO USE THE MOUSE 
 

The mouse is used to select programs on the screen. Moving the mouse around will 
move the cursor around. Move the cursor onto an item to select it. The cursor looks 
like this: 

Image 5 

IMAGE OF CURSOR 

 
Mouses have three components: 

 Left Click: Use this to select things on the screen.  
 Right Click: Use this to open a menu of options. We will learn more about 

this in the Microsoft Word chapter. 
 Scroller: Roll this downwards to move the page down. Roll this upwards to 

move the page up.  

Image 6 

IMAGE OF MOUSE 
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STARTING FROM THE DESKTOP 
 

Once you open the computer, you will be on the ‘desktop’ screen.  

Image 7 

IMAGE OF DESKTOP SCREEN 

On the desktop, you can move the mouse over applications. Double click on the icon 
to open them. LiteHaus International has put the ‘Microsoft Word’ application which 
school and university students use all around the world. This guide will teach you how 
to use Microsoft Word. This is where you can type documents such as letters and 
assignments.  

Left-click this icon on the desktop twice. 

Image 8 

MICROSOFT WORD ICON 
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OPENING A PROGRAM 
Left-click twice the Microsoft Word icon shown on the previous page.  

You should see this screen: 

Image 9 

 
Before we learn how to use Microsoft Word, we need to learn how to close 
applications. In the top right corner of all applications there are three buttons. 

 
 The green outlined button is called “Minimise”. It moves the application to the 

bottom left of the screen. (see Page 10, Image 10 & 11) 
 The yellow outlined button is called “Restore Down”. It makes the application 

window smaller. (see Page 11, Image 12 & 13) 
 The blue outlined button is called “Close”. It closes the application. 
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MINIMISE BUTTON 
Clicking on the Minimise button will put the application to the bottom left hand corner 
of the screen 

Image 10 & Image 11 
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RESTORE DOWN BUTTON 
Clicking the restore-down button will make the application smaller. 

 

To make the application large again, press the restore-down Button again.  

Image 12 & Image 13 
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Typing Master

Week 2 & 3: Lessons 4-9
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SETTING UP – TYPING MASTER 
Using a LiteHaus International-provided computer means the Typing Master program is 
available on the desktop. However, if it is not, it can be downloaded. The full version of the 
program is available for free at this link https://www.typingmaster.com/charity/nations.php 
follow the prompts to get a free code. 

 

1. Click the Typing Master 11 icon on your desktop to start the program.  
2. Choose whether to create a general school account, or each student 

can have their own user depending on class size. 
3. Press enter and go into the program once you have created our 

account. 

Once entered, the following options will be displayed. 

 

 

4. To begin with, there is a fast touch-typing course available to start, this can be done at 
any pace to develop keyboard skills. 
 

• Each student can do this to learn how to effectively use a keyboard with minimal 
looking at the keyboard to see the keys and errors. 
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ACTIVITIES/GAME - TYPING MASTER 
• Explore the other options within the lessons provided. 
• Clicking the games tab in the options on the right-hand side. 

 

 

 

 

 

 

 

 

 

 

 

 

• Inside the games part, there are three activities.  
 

• The activities listed will help to familiarise students with the keyboard. Each activity can 
be changed to a-z which is recommended for first getting used to the keyboard. Once 
comfortable it can be changed to categories which will give you full words. Scores are 
given in all three games. 

o Scoreboards can be kept in the class if you wish as part of a class competition. 
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TYPING TESTS - TYPING MASTER 
1. Click on the Typing Test Tab located on the right-hand side.   

 

 

 

 

 

 

 

 

 

 

 

 

2. Inside the Typing Test Tab there are a few options to choose from. First is the Test Text 
labeled with a number one. Choose a text to use, Scroll down for a larger range.  

3. Next choose the duration, this is marked by the number two. It is set automatically at 
10 minutes, but by clicking down on the tab can be changed to a range of times, from 
1 minute to 30 minutes. This has been marked with a red circle.  

4. Click Start Test to begin. This is placed next to the number three on the picture. This 
will begin the typing test.  
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5. Begin the test by typing the first word. On screen is the text and timer are ready to go. 
Once the first letter H in the sentence is pressed, the timer will begin.  

A couple of tips. 

1. If a mistake is made and noticed after the finished the word, do not try to backspace 
and go to fix it, just continue along.  

2. Use space bars for spaces between words and enter for spaces between paragraphs. 
3. Once finished or when the next button is pressed, the results will be displayed. 

 

 

 

 

 

 

 

 

 

 

Since in this example the test was not finished it has stated above “Test Interrupted”. 

Look at the results of the typing test for some statistics. 

• Gross Speed is how fast the typing is being completed. 5 wpm means typing at roughly 
5 words per minute. 

• Accuracy how well words are being spelt. If the result is 80% of the words being correct, 
that would mean out of 100 words, 80 words correctly spelt. 

• Difficult keys are the keys that were the difficult to find during the test. This is based 
upon how quickly they are pressed compared to the rest of the letters and words typed 
out.  

• The letters listed are the ones that took longer to find and use compared to the rest of 
the letters during the test. 

 

Using this information we can set goals to complete for students: 

• If the wpm (words per minute) is low, then practice to get it higher.  
• If acccuracy is low, work on getting it up by paying more attention to reading and 

typing. 
• If difficulty with keys is the issue, recognise which keys, where they are on the 

keyboard  and practice typing with them.  
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TARGET RESULTS FOR STUDENTS 
Here is a guideline on what students should be aiming for with the testing, most of them should 
be aiming for beginner levels as they are new to computers and typing, Intermediate if they 
are comfortable and Expert if they want to challenge themselves. But most students should 
aim for Intermediate. CPM means Characters Per Minute, but is not shown on typing master, 
this is individual keys pressed. 

 

If adults are partaking and learning this (teaching), then the aim should be as below. Aiming 
for at least the average speed and trying to hit Productive over the next 5 years of teaching.  

 

 

 

 

 

 

 
 

34



Microsoft Word

Week 4: Lessons 10-12

35



MICROSOFT WORD 
On the following page, we have prepared a letter which is addressed to Jack Growden, 
welcoming him to Papua New Guinea.  

Your task is to re-write this letter exactly in the format it is in (including the table, images and 
fonts), to learn the various functionalities of Microsoft Word. 

You will notice that the letter includes the use of a range of text styling techniques, including 
bold, underline, italics, change of colour, and text highlight. It also includes a table and two 
images. The LiteHaus letterhead image can be found on your accompanying USB stick as 
‘Letterhead”. The ‘houses’ image can be found on the same USB stick as “PNG Image 1”.  

Below are your instructions: 

1. Open a blank Microsoft Word document. Microsoft Word can be found by clicking the 
Windows Menu button in the bottom left corner of your screen:  

2. Once Microsoft Word is opened, click ‘Blank Document’. 
3. Begin typing the text, ignoring the styling, images and table for now – once you 

have typed the entire text, we will move on with these. 
4. Create a list for the following: Lush rainforests; towering mountain ranges; pristine 

beaches; and vibrant coral reefs 
a. To create a list, space these points out line by line using the Enter key: 

 

b. Select all lines by left clicking (HOLD) and dragging across the text with your 
right hand.  

 

 

 

 

 

c. Click the list button in the Home tab which looks like this: 
d. The list should now look like this: 
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Once you have written all of the text, including the list above, it is time to begin styling the 
letter. Let’s start by adding the pictures. 

1. Insert the USB flash drive provided. 
2. Click on File Explorer at the bottom of your screen:  
3. Click on USB Drive (D:):  
4. In the folder, you should find ‘PNG Image 1’, click to open it. 
5. Right-click on the image and select Copy. 
6. Return to your Microsoft Word document and click in the appropriate location in the 

letter where the image will be being placed. 
7. Right-click and select Paste.  
8. The image in its current form will be too big for the space provided. Therefore, we need 

to crop the image. To do this: 
a. Select the image and click on ‘Picture Format’ tab at the top of your screen. 
b. Click on Crop. 
c. The corners of the image will now have black lines click and hold on the top 

right hand corner of the image and drag it down to cut out the sky. Then click 
and hold the bottom right hand corner of the image and drag it up to remove 
most of the grass. The image should now look like this: 

 

9. The image should now fit neatly on the bottom of the first page of the letter. 
10. Now let’s add the letterhead. Once again, click on File Explorer at the bottom of the 

screen and open ‘Letterhead’ 
11. Right-click on the image and select Copy. 
12. Return to your Microsoft Word document and click at the top of the letter where the 

image will be being placed. 
13. Right-click and select Paste.  
14. You will notice that the image does not stretch exactly to the margins. To fix this, select 

the image and click on ‘Picture Format’ tab at the top of your screen. 
15. Click on Wrap Text and select “Behind Text”. This will make the image more flexible 

and easier to move. 
16. Now, resize the image and stretch it right to the margins by clicking on the image and 

then clicking, holding and dragging the image to the corners of the document. 
17. You may need to enter the text down so that it starts neatly below the letterhead. 

Your letter should now have both images neatly included as shown in the example letter. Now, 
it is time to add the table following these steps: 
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1. Select the Insert tab. Then click on the Table icon and drop-down menu. 
2. Here, you can select the number of rows and columns by clicking on the grid which 

looks like this: 

 

3. Create a table with 3 columns and 5 rows. It will look like this at first: 

   
   
   
   
   

 

4. Begin adding in the text so that your table looks like the below. To create a number list, 
go to the Home tab and click on this button: 

5. Your table should now look like this: 

Year levels Gender Highest Numbers 
Year 5 Males: 57 

Females: 45 
Males 

Year 6 Males:35 
Females:46 

Females 

Year 7 Males: 75 
Females:50 

Males 

Year 8 Males:59 
Females: 60 

Females 

 

1. Now, the columns need to be re-aligned. To do that, select the first column, click the 
Layout tab and the click the Centre Align button which looks like this:  

2. While you have the first column still selected, click on the bold icon in the Home tab. 
It looks like this: 

3. Repeat Step 6 for the third column, but not the second column. 
4. Now we need to bold and shade the top row. To do that, select the top row and, firstly, 

press the bold icon. Secondly, click the Table Design tab in the toolbar, and click on 
the Shading drop down menu. It looks like this: 

 

  

 

 

5. Your table should now look exactly like the example letter template. 

Now it is time to style the text throughout the document, following the instructions below: 
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Bolding Text:  

• Select the text, then click on the bold icon in the Home tab. It looks like this: 

Underlining Text: 

• Select the text, then click on the underline icon in the Home tab. It looks like this: 

Italicising Text: 

• Select the text, then click on the italics icon in the Home tab. It looks like this: 

Changing Text Colour: 

• Select the text, then click on the dropdown menu next to this icon:     . Select colour. 

Highlighting Text: 

• Select the text, then click on the dropdown menu next to this icon:  

Enlarging Text: 

• Select the text, then click on the dropdown menu next to this icon: 

 

Now to put the finishing touches on the letter by signing off. You will see in the template that it 
asks for your name and your title. Amend this to suit you. Create a gap between “Warm 
Regards,” and your name. This is where we will add your signature. 

To create your signature: 

1. Click on the Draw tab in your toolbar. 
2. Select the black pen icon to the right. 
3. ALERT: Now your mouse is operating as a pen. To use the pen, left click and hold 

with your left hand. With your right hand, drag the mouse along to make your signature. 
Be gentle and take your time as the mouse is touchy. 

4. If you are unhappy with your first attempt, press CTRL+Z to undo. 
5. Once you are satisfied, be sure to return to the Draw tab and click the mouse icon to 

deactivate the pen function. 

You have now completed the letter. Now save the document by clicking the save icon.   
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(Name) Your Name Here             (Date) 19th September 2024 

School Name Here 

 

RE: Pen Pal Letter – Learning each other’s cultures 
 

Dear Australian Friend, 

I hope this letter finds you in great health and high spirits. I would like to tell you a bit about 
my home country and my Village. 

Papua New Guinea, located in the South Pacific/Oceania, is a land of incredible diversity 
and breathtaking landscapes. These include:  

• Lush rainforests; 
• towering mountain ranges; 
• pristine beaches; 
• and vibrant coral reefs. 

PNG offers a unique blend of natural beauty that is second to none. Whether you're trekking 
through the rugged terrain of the Kokoda Track, exploring the enchanting Sepik River, or diving 
into the mesmerizing underwater world of Milne Bay, PNG promises unforgettable adventures. 

 

This is a picture of my home; we use a lot of natural resources and live a good life. We live in 
a small village, out in our beautiful rainforest. There are a lot of trees, grass and a lot of work. 
We love our farming and pride ourselves on our food that we grow and enjoy. My favourite 
food is Kau Kau which is like a sweet potato.  
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I have a few questions about Australia. 

1. What is your life like in Australia? 
2. Do you live similarly to the way we live? 
3. What is your favourite food from Australia? 
4. Do you have questions for me about Papau New Guinea? 

I hope to receive a response from you soon! 

 

All the best, 

 

Your Name Here 
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Microsoft Excel

Week 5-7: Lessons 13-22
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MICROSOFT EXCEL 
On the following page, we have compiled hypothetical student enrolment data from across 
imaginary schools.  

Your task is to enter the data accurately into spreadsheet using Microsoft Excel, and then 
analyse the data to determine the answers to the following questions: 

 

1. Which region has the most schools? 
2. Which region has the most students in total? 

a. Express in a bar graph. 
b. Express this in pie chart. 

3. Which region has the most female students in total? 
4. Which region has the highest average number of students per school?      
5. Which school is the biggest in the country? 
6. Which school is the biggest in the Southern region by population? 

 

To begin the task: 

1. Open Microsoft Excel, which can be found by clicking the Windows Menu button in the 
bottom left corner of your screen: 

2. Select ‘Blank Worksheet’. 
3. Fill in the sheet like below: 

 

 

 

 

 

 

To do this, you will need to: 

1. Adjust the size of the columns by left clicking and holding the line that separates 
column A and column B, for example, and dragging them to fit.  

2. You will see that Grade 9, Grade 10, Grade 11 and Grade 12 fit neatly across all of the 
M, F, T columns. To achieve this 

a. Select cell C1, D1, and E1 and press Merge and Centre icon: 

You will now be wondering how to get the Total number of students automatically, for each 
grade as these are not provided in the data.  

For this, we will use the first of many Excel Formulas.  

Formulas instruct the computer to calculate and measure certain things based on certain 
variables.  
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Below is a summary of formulas which we will use to analyse the data: 

SUM – To add up numbers. 

SUMIF – To add up numbers based on criteria. 

SUMIFS – To add up numbers based on multiple criteria. 

COUNTIF – To count based on a criteria. 

COUNTIFS – To count based on multiple criteria. 

MAX – To find the highest value in the list. 

AVERAGE – To find the average value of a list. 

To add up the total students per grade, per school, we will use the SUM function. To do this: 

1. Click in the blank Total column for Alpha School, Grade 9.  
2. Enter the following: =sum( and then select both D3 and C3. Your formula will now looks 

like =sum(C3:D3. Close the brackets so it looks like this: =sum(C3:D3). Press enter. 
3. To save you from having to write that for every single school’s Grade 9 total, click on 

the Total for Alpha School and left click, hold and drag from the bottom right-hand 
corner of the field all the way down to the last school. Once you release your hold, all 
the values will automatically appear. 

a. Repeat Steps 2 & 3 for each of Grades 10, 11 and 12. 
4. Add in a final column called ‘Grand Total’ at the end of the sheet and use the SUM 

function to add up all of the Total columns for each school. This will give you the total 
number of students in the school. To do that: 

a. Press =sum( and then select E3. Then add a + and then add H3. Then add a 
+ and then add K3. Then add a + and add N3. Then close the brackets. Your 
formula should now look like this: =sum(E3+H3+K3+N3). Press enter. 

b. Repeat Step 3 for the Grand Totals column to list all the values down the sheet. 
5. Repeat Step 4 and then Step 3 to add ‘Total Females’ and ‘Total Males’ columns. To 

Insert Columns (and rows when required) click on Insert in the Home Tab and a 
dropdown menu will appear. Click on Insert Sheet Columns as below: 

 

Note for reference, that when writing Excel formulas, everything needs to be precise. We have 
touched on adding numbers together above, but to subtract, multiply and divide them: 

• * - Multiply in Excel Formula 
• / - Divide in Excel Formula 
• + - Add in Excel Formula 

• - - Subtract in Excel Formula 
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Now our spreadsheet will enable us to begin data analysis. To answer Q1, we need to create 
a table below the data like this: 

 

Now: 

1. Click in the Momase/Number of Schools field and press the Formulas tab in the toolbar, 
then click Insert Function. This is a critical button which will be used throughout the 
analysis, so please note it on the very left below: 

 

 

 

2. Select COUNTIF from the list of formulas. This will instruct Excel to count the number 
of schools in each region.  

3. Select the Range by clicking on B3 and dragging it down to B14 to select all regions. 
4. Add Momase into the Criteria field. 
5. Press Enter. 

 

6. Repeat these steps for each of the regions: Islands, Southern, Highlands until your 
table looks like the below. You will see that Southern is the answer to Q1. 

 

 

 

 

 

Note: if you are getting zero values, ensure that you are entering the criteria/region in 
absolutely identical to what you have listed in the data. 

To answer Q2, we need to use the SUMIF function to add up the total number of students per 
region. To do that: 

6. Click in the Momase/Students field and press the Formulas tab in the toolbar, then click 
Insert Function, just like in Step 1. 

7. Select SUMIF from the list of functions. This will instruct Excel to add up the number 
of students in each region.  

8. Again, select the Range by clicking on B3 and dragging it down to B14 to select all 
regions. 
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9. Again, add Momase as the Criteria. 
10. For the Sum Range, go to the Grand Total column and click and drag O3 to O14. 
11. Press Enter. 

 

12. Repeat the above steps now for each of the regions. 

Your table should now look like this: 

 

 

 

 

Now, you can clearly see that the answer to Q2 is Highlands. 

Now, you can express this in both a Bar Chart and a Pie Chart. To create a Bar Chart: 

13. Select the regions list (Region, Momase, Islands, Southern, Highlands) and then 
press and hold CTRL and then select the students list (Students, 988, 698, 1321, 
3460) 

a. You will know that they are selected when they are highlighted in black. 
14. Click on the Insert tab in the toolbar, and select the bar chart icon. 

 

15. Select the first 2-D column graph option.  

You will notice that your graph looks like this: 
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Now we need to edit the title. To do that, click on the ‘Chart Title’ and amend it to ‘Total Students 
by Region in PNG’.  

We will now add data labels to each of the bars. To do this: 

16. Click on the graph. 
17. Click on the Chart Design tab and then click on Add Chart Element, Data Labels, 

Outside End. 

 

 

 

 

 

 

 

 

 
 
Your graph should now look like this: 
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18. To create a pie chart, follow the same steps, but instead click on 2-D Pie chart. 

 
 
 
 
Once you add the data labels and change the title by following the previous steps, the pie 
chart should appear like below: 

 
 

 

 

 

 

 

 

 

 

 

To answer Q3, we have to use the SUMIF function, but instead of adding up the Grand Total, 
we need to add a new column called Female Total and use that. 

19. Create a Female Total column following the instructions in Step 4 of Page 8. 
20. Return to your smaller table and click in the Momase/Female Students field. 
21. Press Insert Function and add in the variables listed below, then press ENTER. 

 

22. Repeat this step for each region.  

Your table should look like the below. We can see that the answer to Q3 is Highlands. 

 

48



You may choose to also express this in a bar or pie chart as an extra activity. 

To answer Q4, we need to add another column into our smaller analysis table called ‘Average 
Students Per School’. To calculate this, we need to use the SUM function again. 

23. Click in the Momase/Average Students Per School field. 
24. Type =sum( and then select the total number of students for Momase field. Then type 

the symbol: / and then select the number of schools for Momase field. Press enter. 
a. Your formula should be: =sum(Number of students/Number of Schools) 

25. Repeat this step for each of the regions until your table looks like this: 

 

You will notice that the decimal places are untidy. To fix this: 

1. Click on the 329.33333333 value. 
2. Click on the decrease decimal icon in the Home tab.  
3. Repeat this step for each of the values.  

Now, we can clearly see that the answer to Q4 is again, the Highlands. 

 

To answer Q5 & Q6, we will now learn how to Sort & Filter.  

• Sorting is the process of manipulating a list so that it is placed in a particular order 
(i.e. A to Z or Highest to Lowest). 

• Filtering is the process of removing pieces of information to leave a refined list. 

 

Let’s answer Q5 first by using the Sorting function. 

4. Go to your Grand Total column and select all values. 
5. In the Home Tab, click Sort & Filter and then Sort Largest to Smallest. 

 

6. When you click this, it will come up with a ‘Sort Warning’ – refer the following page. 
Click Expand the Selection and then Sort. 
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You will notice that the schools are now in the list of largest to smallest. 

As such, we can see that the answer to Q5 is Kilo School. 

 

To answer, Q6, we have to use the Filtering function.  

7. Click on cell A2 – School Name.  
8. Click on the Sort & Filter icon again and then press Filter.  
9. You will notice that next to every heading in that row, a little arrow has appeared. 

Click on the arrow next to Region. 
10. You will see this list: 

 

11. Untick all of the regions except for Southern and press OK.  

Now you should only see the four schools in Southern listed. Therefore, we can see that the 
answer to Q6 is Golf School. 

To return your data sheet to its original form, re-select all the regions in the Filter function. 
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SECONDARY SCHOOL ENROLMENT DATA 
 

Alpha School – Momase Region 

Grade 9 (64 M | 49 F), Grade 10 (55 M | 40 F), Grade 11 (39 M | 39 F), Grade 12 (32 M | 8 F) 

 

Bravo School – Momase Region 

Grade 9 (62 M | 47 F), Grade 10 (56 M | 42 F), Grade 11 (45 M | 38 F), Grade 12 (34 M | 9 F) 

 

Charlie School – Momase Region 

Grade 9 (68 M | 49 F), Grade 10 (53 M | 41 F), Grade 11 (41 M | 35 F), Grade 12 (31 M | 11 
F) 

 

Delta School – Islands Region 

Grade 9 (73 M | 50 F), Grade 10 (58 M | 44 F), Grade 11 (37 M | 34 F), Grade 12 (29 M | 28 
F) 

 

Echo School – Islands Region 

Grade 9 (59 M | 46 F), Grade 10 (54 M | 40 F), Grade 11 (43 M | 36 F), Grade 12 (32 M | 35 
F) 

 

Foxtrot School – Southern Region 

Grade 9 (67 M | 48 F), Grade 10 (57 M | 43 F), Grade 11 (40 M | 33 F), Grade 12 (30 M | 12 
F) 

 

Golf School – Southern Region 

Grade 9 (71 M | 51 F), Grade 10 (52 M | 45 F), Grade 11 (39 M | 37 F), Grade 12 (33 M | 7 F) 

 

Hotel School – Southern Region 

Grade 9 (63 M | 52 F), Grade 10 (60 M | 39 F), Grade 11 (42 M | 31 F), Grade 12 (35 M | 10 
F) 

 

India School – Southern Region  

Grade 9 (69 M | 47 F), Grade 10 (55 M | 42 F), Grade 11 (38 M | 32 F), Grade 12 (28 M | 13 
F) 
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Juliett School – Highlands Region 

Grade 9 (128 M | 96 F), Grade 10 (384 M | 288 F), Grade 11 (82 M | 66 F), Grade 12 (58 M | 
24 F) 

 

Kilo School – Highlands Region 

Grade 9 (144 M | 98 F), Grade 10 (432 M | 282 F), Grade 11 (76 M | 72 F), Grade 12 (62 M | 
20 F) 

 

Lima School – Highlands Region 

Grade 9 (136 M | 94 F), Grade 10 (408 M | 282 F), Grade 11 (74 M | 72 F), Grade 12 (66 M | 
16 F) 
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FORMULAS FOR EXCEL 
Dates and Time Excel Formulas 

• =EDATE – add a specified number of months to a date in Excel 
• =EOMONTH – convert a date to the last day of the month (e.g., 18/7/2018 to 

31/7/2018) 
• =DATE – Returns a number that represents the date (yyyy/mm/dd) in Excel. This 

formula is useful when working with Excel functions that have a date as an argument. 
• =TODAY – insert and display today’s date in a cell 
• =NETWORKDAYS – Returns the number of whole workdays between two specified 

dates. 
• =YEAR – extracts and displays the year from a date (e.g., 18/7/2018 to 2018) in Excel 
• =YEARFRAC – expresses the fraction of a year between two dates (e.g., 1/1/2018 – 

3/31/2018 = 0.25) 

 
Lookup Formulas 

• =VLOOKUP – a lookup function that searches vertically in a table 
• =HLOOKUP – a lookup function that searches horizontally in a table 
• =INDEX – a lookup function that searches vertically and horizontally in a table 
• =MATCH – returns the position of a value in a series 
• =OFFSET – moves the reference of a cell by the number of rows and/or columns 

specified 

 
Math Functions Excel Formulas 

• =SUM – add the total of a series of numbers 
• =AVERAGE – calculates the average of a series of numbers 
• =MEDIAN – returns the median average number of a series 
• =SUMPRODUCT – calculates the weighted average, very useful for financial analysis 
• =PRODUCT – multiplies all of a series of numbers 
• =ROUNDDOWN – rounds a number to the specified number of digits 
• =ROUNDUP – the formula rounds a number to the specific number of digits 
• AutoSum – a shortcut to quickly sum a series of numbers 
• =ABS – returns the absolute value of a number 
• =PI – Returns the value of pi, accurate to 15 digits 
• =SUMIF – sum values in a range that are specified by a condition 
• =SUMQ – Returns the sum of the squares of the arguments 
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Financial Formulas 

• =NPV – calculates the net present value of cash flows based on a discount rate 
• =XNPV – calculates the NPV of cash flows based on a discount rate and specific dates 
• =IRR – this formula calculates the internal rate of return (discount rate that sets the 

NPV to zero) 
• =XIRR – calculates the internal rate of return (discount rate that sets the NPV to zero) 

with specified dates 
• =YIELD – returns the yield of a security based on maturity, face value, and interest rate 
• =FV – calculates the future value of an investment with constant periodic payments 

and a constant interest rate 
• =PV – calculates the present value of an investment 
• =INTRATE – the interest rate on a fully invested security 
• =IPMT – this formula returns the interest payments on a debt security 
• =PMT – this function returns the total payment (debt and interest) on a debt security 
• =PRICE – calculates the price per $100 face value of a periodic coupon bond 
• =DB – calculates depreciation based on the fixed-declining balance method 
• =DDB – calculates depreciation based on the double-declining balance method 
• =SLN – calculates depreciation based on the straight-line method 

 

Conditional Functions 

• =IF – checks if a condition is met and returns a value if yes and if no 
• =OR – checks if any conditions are met and returns only “TRUE” or “FALSE” 
• =XOR – the “exclusive or” statement returns true if the number of TRUE statements is 

odd 
• =AND – checks if all conditions are met and returns only “TRUE” or “FALSE” 
• =NOT – changes “TRUE” to “FALSE”, and “FALSE” to “TRUE” 
• IF AND – combine IF with AND to have multiple conditions 
• =IFERROR – if a cell contains an error, you can tell Excel to display an alternative 

result 
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Microsoft PowerPoint

Week 8: Lessons 20-22
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MICROSOFT POWERPOINT 
In the previous exercise, we analysed student data to create various graphs and tables. 
However, this is not a neat format for presenting to large groups at formal events. Instead, 
Microsoft PowerPoint is the best option. 

In this task, we will create a PowerPoint presentation titled “Analysis of Student Data in PNG” 
and include our key findings and graphs. 

To begin the task: 

1. Open Microsoft PowerPoint, which can be found by clicking the Windows Menu button 
in the bottom left corner of your screen:  

2. Select ‘Blank Presentation’. 
3. Click on the Design tab and select a design. We recommend the third option (in green 

below). 

 

4. Change the Title to “Analysis of Student Data in PNG” and the Subtitle to “Provincial 
Department of Education”. 

 

5. Insert a new slide by clicking New Slide. Be sure to select ‘Title & Content’ as the 
format.  

6. Change the title to ‘Key Findings’. 
7. In the textbox below, you will see that it has automatically started a list. Go ahead and 

write six dotpoints listing the following from the data in your Excel sheet: 
a. The total number of students in PNG is XXXX 
b. The total number of schools in PNG is XXXX 
c. The region with the largest number of schools is XXXX 
d. The region with the largest number of students is XXXX 
e. The average number of students per school is XXXX 
f. The largest school in PNG is XXXX 

8. Insert a new slide by clicking New Slide. Be sure to select “Title Only” as the format. 
9. Change the title to ‘Regions of PNG’. 
10. Copy (CTRL-C) and Paste (CTRL-V) the graph titled Total Students By Region from 

the Excel sheet into the vacant space on this slide. 
11. Repeat these steps for each graph that was produced in the Excel sheet, inserting new 

slides when required. 
12. Add a new slide by clicking New Slide. Be sure to select “Blank” as the format. Then 

copy and paste the image ‘PNG Image 1’ on the page. This will be our end page. 
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To add artistic transitions into the slideshow, click on the Transitions tab and select from the 
options below. We recommend ‘Wipe’.  

 

To ensure that this is consistent throughout the presentation, press Apply to All on the right 
hand side of the toolbar (see above). 

 

To enter Presentation Mode (which will make your slideshow full screen), click the Slide Show 
tab and then the From Beginning icon. Now your slideshow will be full screen. To click through 
your slides, press the Space Bar. 

 

BEST PRACTICE – PRESENTATION TIPS 

• Less is best – adding too much text to the screen can confuse the viewer. 
o You can always say more in your speech. The PowerPoint should just be there 

to re-enforce what you have to say. 
• Less is best (again!) – be sure to limit the variety of transitions and colours used. 

o Random movements on the screen can distract the viewer. 
• Always use an existing ‘Design’ to improve professionalism of style. 
• Make sure all images and text boxes are neatly aligned to each other. 
• Use a simple, professional font. Remember – it is the content of the presentation that 

the audience is interested in. 
• Always use Presentation Mode when presenting. 
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Assessment
Materials

Weeks 7, 8, 9
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EXCEL ASSESSMENT 
You have been asked to check the ability of the schools in the area to teach students. The government 
has asked that you check that each school meets the following criteria: 

1. 1 classroom for every 30 students 
o Make another column. Use ratios (refer to page 13) to calculate students per classroom 

2. 1 Teacher for every 30 students 
o Make another column. Use ratios (refer to page 13) to calculate students per teacher. 

3. The government also wants to know the overall numbers of students and teachers. 
o Use SUM function to calculate (Refer to page 13) 

4. How many places do not meet 1 Classroom, 1 Teacher for every 30 students. 
o Refer to page 13 to help you to find the ratios. 

5. Which needs the immediate attention? For every 1 classroom and 1 teacher under per 30 
students 

o Use filter function to find this answer (refer to page 13-14) 
6. Rank from top priority to less necessary, based on your results. 

o Use the filter function to help you rank this (refer to page 13-14) 

7. Make a graph of the number of students in each region, the numbers of schools, Teachers (one 
pie graph and one bar chart required) use the data from countif to help complete (refer to 
page 9-12) 

 

MAKE SURE TO USE SUMIF AND COUNTIF TO HELP YOU WITH CALCULATIONS. 

 
Wood School (Northern Region) - 68 Students, 1 Teacher, 1 Classroom 

John School (Western Region) - 90 students, 2 Teachers, 2 Classrooms 

Oak School (Eastern Region) - 150 Students, 7 Teachers, 6 Classrooms 

Oil School (Southern Region)- 100 Students, 2 Teachers, 2 Classrooms 

Rock School – (Northern Region) 88 Students, 2 Teachers, 1 Classroom 

Tree School – (Northern Region)125 Students, 2 Teachers, 2 Classrooms 

Fish school – (Western Region) 190 Students, 5 Teachers, 4 Classrooms 

Lone School – (Southern Region) 166 students, 8 Teachers, 6 Classrooms 

Cart School – (Western Region) 79 Students, 2 Teachers, 3 Classrooms 

Care School – (Eastern Region) 142 students, 4 Teachers, 5 Classrooms 

Friend School- (Northern Region) 135 Students, 3 Teachers, 3 Classrooms 

Thursday School – (Eastern Region) 99 Students, 3 Teachers, 3 Classrooms 

Coral School – (Western Region) 83 Students, 3 Teachers, 3 Classrooms 

Great School – (Southern Region) 52 Students, 2 Teachers, 2 Classrooms 

Cool School – (Eastern Region) 177 Students, 4 Teachers, 5 Classrooms 

 

Your table should include the following columns in your excel spreadsheet with these titles: schools, 
region, students, teachers, classrooms. 
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WORD ASSESSMENT 
Based upon your findings in the Excel assessment, write to the government with your results, explaining 
what schools are in dire need of attention and what the solutions are to solve the numbers issues for 
students, to teachers, to classroom numbers. You will need to provide an idea of how much time you 
expect these projects to take and a timeframe you believe this needs to be completed by.  

Example of Template On Following Page 
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Jack Growden                28th February 2024 

LiteHaus International 

Founder & CEO 

 

RE: Official Review of Schools in Papua New Guinea 
 

Dear Jack, 

At your request, a formal investigation of each school was conducted in order to find out the 
following information. The number of students, teachers, and classrooms in each region 
of Papua New Guinea. With this information we have collected, we have created graphs to 
show the following data for out education system: 

• Number of teachers per 30 students 
• Number of classrooms per 30 students 
• How many schools meet the required number of teachers and classrooms 

With this data, I have been able to see which ones are in dire need of attention to have enough 
classrooms and teachers per 30 students. I have completed a table to show the data below: 

Region Schools Number of 
students/teachers/classrooms 

Northern   
Southern   
Western   
Eastern   

 

With this data shown in the table, I have identified the schools needing more classrooms and 
teachers. I have provided some solutions including: 

• Which schools should be completed first 
• What method I suggest to increase the number of teachers and classrooms 

TALK ABOUT SOLUTIONS HERE 

I am available from the 15th February – 20th June, after which I will be taking a well-deserved 
break for 2 weeks. Please contact Jienelle to negotiate a time to meet. 

 

Warm regards, 

 

YOUR NAME 
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POWERPOINT ASSESSMENT 
The government has asked you to present your finding to the team at their offices, you have the script 
ready for what you will say. But you need a PowerPoint presentation to assist you during the talking. 
You will need to grab the key points from your letter and Spreadsheet, place them into slides and make 
them grab the viewers’ attention. Make sure to not use too many words and use images to help make 
it appealing.  

Use the template provided below to help you: 
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Scratch

Week 8: Lessons 26-28

63



Scratch 
Scratch is a free to use software that allows you to start practicing coding, simple coding that 
makes animations & games. 

 

 

 

 

 

 

 

 

 

This guide will not have as much information on the actual activities for the program, as they 
have been provided in video format for you in the Scratch Coding folder, in the ICT Folder 
located inside the proivded LiteHaus E-Library English folder provided. 

 

 

 

 

Inside the Scratch folder as shown above, is the Scratch installer. Within the same area is also 
several tutorials we have provided. Go through these as a class together with the program. 

 

Within the Unit plan and curriculum are some of the videos it is recommended the class to 
look at first.  
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This is a very basic introduction to Scratch. The videos provided will assist with the rest of the 
training. 

1. Open Scratch to see the screen displayed. 

 

2. This will be the default screen that comes up each time. There are several actions that 
can be made from here.  
• Start an individual project. 
• Look at the costumes, sounds and other actions available. 
• Open any past project and continue to work on it. 

3. Begin by exploring the functions on the scratch screen. 
• The Green circle is where a sprite can be chosen, which can be a different 

character to the one on screen. 
• The Red circle is where a background for the character can be chosen. 
• The Yellow circle is where sounds can be recorded, as well as a number of sounds 

can be chosen from that are provided. 
• The Pink circle is where changes to the characters can be made, such as giving the 

cat a hat or wings. A unique character can be created as well. 
•   
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4. Time to explore what can be done with Scratch, on the left-hand side is a number of 
colours and tabs. This will help with coding the sprite. 
• Go to the left which currently has motion open. Click and drag one of the 

commands onto the screen as shown below. 
• Click on the blue piece placed, it will now move the sprite. 

5. If pressed enough times the character will move across the small screen to the right. 

Before 
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After 

 

• Notice that the sprite has moved to the edge of the space that it has available to it. 
This is a basic movement and the beginning of what can be achieved. 

 

There are many more commands and functions to try. It is recommended to begin with the 
video How to Make a Story in Scratch _ Tutorial as it will show the basics of using 
characters, backgrounds and movements. 

 

 

 

  

 

 

Once comfortable with this, start to explore and use other videos available to you in the folder. 
Have fun trying different commands with Scratch as it is meant to be played with and for 
students to have a go and learn. Remember that mistakes are natural in order to figure out 
what went wrong, then fix them. Errors are a part of coding and learning. Mistakes will be 
made many times and that is ok.  
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E-Safety Modules

Week 10 & 11: Lessons 29-34
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LiteHaus International E-Safety Modules 
On your device, eleven e-safety modules have been provided which will be useful for teaching 
students about online safety and much more. These are located in the LiteHaus Modules 
folder as shown below. 

 

 

It is recommended going through Chapters 1-5 & Chapter 9 with the students to begin with. 
Then completing the others throughout the school year. It would also be beneficial for parents 
to be involved and come learn about it as well. 

Notes have been put into the PowerPoints. It is recommended before presenting each one to 
look at each slide and read the notes located below as pictured here. 

 

 

Note: This may not always be needed as the slide may provide the information needed already. 
So, if it is blank, it is because the information is already on the slide that is necessary. 
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